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Z100™ Electrochemical Impedance Analyzer

Electrochemical Impedance Spectroscopy (EIS) has emerged as a powerful technique for defining
reaction mechanisms and physical structures involved in a wide variety of electrochemical applications
including

e Biological systems
e Surface structures
e Corrosion processes
e Battery and fuel cell

The EDAQ Z100™ EIS System provides the means to turn an existing potentiostat/galvanostat into a fully
functioning EIS System with full analysis and modeling capability.

The single channel Z100 is based on the experience gained from the development of a 6 channel EIS
system and includes many useful enhancements.

The complete system is software controlled and all functions such as ranging, calibration, and
measurements can be automated.

This manual describes the Z100 Navigator software application which controls and sets up the operating
parameters of the Z100 system. Standard Features for the Z100 include the following:

e Specially Designed for AC Impedance Experiments

e Versatile Waveform Generator/Analyzer

e Frequency Range of 1 pHz to 100 kHz

e Data Presentation, Analysis and Modeling with ZMAN software

e 1 Qutput for the Excitation voltage

e 2 Analog Inputs: 1 for Current and 1 for Voltage Response Auto ranging
e High Speed USB Interface

With the help of Z100 Navigator software, the Z100 and EDAQ EA163 potentiostat provide the means
to perform a number of common electrochemical impedance spectroscopy (EIS) experiments.

The available techniques and Setup Parameters are described in the sections that follow and are detailed
below — Available techniques.
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Available Techniques

The basic function of the Z100 is to generate predefined periodic excitation waveforms, apply them to a
system under test and to measure the resulting current and voltage magnitude and phase responses
simultaneously. The Z100 system is normally supplied with an EA163 POTENTIOSTAT connected via 12C
bus to the Z100. This configuration supports PEIS, GEIS & GHFR.

3rd party potentiostats/galvanostats and Electronic Loads are also supported — contact EDAQ for details.
With waveforms and analysis methods provided, the following EIS techniques are available with Z100
Navigator software.

List of Techniques

With an EA163 POTENTIOSTAT or 3rd party potentiostat/galvanostat
e Potentiostatic Electrochemical Impedance Spectroscopy (PEIS)
e Galvanostatic Electrochemical Impedance Spectroscopy (GEIS)

e Galvanostatic High Frequency Resistometry (GHFR)

Other techniques can be implemented with the Z100 - contact eDAQ to discuss your
application.

Potentiostatic Electrochemical Impedance Spectroscopy (PEIS)

The Z100 can measure a full impedance spectrum over a selected frequency range using the EA163
POTENTIOSTAT in potentiostatic mode. The sample under test is driven by a small AC potential
superimposed on a DC (Bias) Potential (Figure 1). The resulting AC current magnitude and phase is
measured. This is repeated for every selected frequency to build up the impedance spectrum.

The parameters that are accessible to control the experiment are detailed below.

L

Potential (V)

- AC'Amplitude(m)

S ! | JA E Jannns
\ | \ DC Bias(mV)

Tl'me{s);

Figure 1 PEIS Applied Waveform

Potentiostatic EIS and Setup Parameters

Parameters listed below and displayed in Figure 2 can be changed or alternatives selected by double
clicking on the item.

Delay, Delay Time [s], Delay Stability [mV/s]: Reserved for future use
DC Potential: DC potential applied to sample during experiment. Default O Volts.
AC Amplitude: Amplitude of sinusoidal excitation superimposed on DC Potential. Default 100mV.
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Initial Frequency [Hz]: The starting frequency. See Note on Frequency selection below.
Mid Frequency [Hz]: The frequency at which the frequency steps alter their direction.
Final Frequency [Hz]: The final frequency reached.

Density [points/decade]: Sets the number of points in a frequency sweep decade. Typical value is
10/decade. It can range from 1 to 5000. Default is 5 points/frequency decade.

Iteration: Sets the number of frequency sweeps performed. Default is 1.
Current Range [mA]: Sets the required POTENTIOSTAT current range. Typically start at 10mA range.

Cycle Limit: Number of high frequency cycles measured. High frequency measurements are subject to
noise and increasing Cycle limits may reduce this effect through averaging.

Min Cycle: minimum number of cycles measured at slow speeds
Time Limit: Max time per frequency provided Minimum cycles is executed.
Cell: selects one of 3 conditions:

Standby: in this state the potentiostat will be disconnected from the external cell. When an
experiment is performed the external cell will be automatically connected to the potentiostat,
the experiment completed and the external cell is then automatically disconnected.

Dummy: The potentiostat is connected to the internal 100 kohm dummy cell.
Real Cell: in this state the real cell is connected to the potentiostat and remains connected.

High Stability: sets Hi Stability mode (reduced frequency response) True ON- False —OFF. This setting is
used if the external cell characteristics induce an unstable state (Oscillation). This condition is
automatically invoked in the galvanostatic mode.

Phase correction: Corrects for phase shift due to instrumentation. True ON, False Off

t Potentiostatic EIS

Parameters
A
DZ Pokential 0[v]
AC amplitude 100 [mi]
Initial Frequency 100k [Hz]
Mid Frequency 100k [Hz]
Final Frequency 10 [Hz]
Density 5 [ptidec]
Iteration 1
Current Range 10rma
Cycle Limit 16
- Min Cycle i
- Tirme Limit 2[s]
el Standby
Hi Stability FALSE
Phase Correction FALSE
w
| (o]:4 | [ Cancel

Figure 2 Potentiostatic EIS setup window
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Galvanostatic Electrochemical Impedance Spectroscopy (GEIS)

The Z100 will measure a full impedance spectrum using the EA163 POTENTIOSTAT in galvanostatic
mode. The sample under test is driven by a small AC current superimposed on a DC (Bias) Current
(Figure 3). The resulting AC voltage magnitude and phase is measured. This is repeated for every

selected frequency to build up the impedance spectrum.

The parameters that are accessible to control the experiment are detailed below.

»
=

Current(l)

‘./‘ N\ A N

H \
/ \ i AC‘amplitude(ma)
‘ ¥
..ll....l. EEEEER IIIIIIIIIIIIJ...I.
\ / \ / DC Bias(mA)
\ / \ J
\, / N

Time(s)

Figure 3 GEIS applied waveform

Galvanostatic EIS and Setup Parameters

A List of Setup Parameters similar to those described above is available to setup conditions for a GEIS
experiment.

Galvanostatic HFR (GHFR)

7100 will measure time-evolved impedance data at fixed frequencies, see Figure 4, using the EA163
POTENTIOSTAT operating in the galvanostat mode.

b

Current(])

Time(s)

Figure 4 GHFR Applied waveforms

Galvanostatic HFR and Setup Parameters

List of Setup Parameters

Delay, Delay Time [s], Delay Stability [mV/s]: Reserved for future

DC Current [mA] +AC Amplitude [mA]: Small sinusoidal perturebation signal with amplitude of AC
Amplitude is superimposed on DC Current.
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Frequency [Hz]: To set a single frequency

Iteration: To set how many measurements will take

Interval [s]: To set interval between two successive measurements.

Current Range [mA]: To set desired current range of EA163 POTENTIOSTAT

Note on Frequency selection:

Frequency will be scanned from “initial” to “mid” and stop on “final”. The scan has no preferred
direction — the system can scan from high to low or low to high. The typical and preferred direction of
frequency scanning is from high to low. Scanning at high frequencies is faster and inappropriate
settings can be more quickly identified. Scanning at low frequencies, for example at TmHz, takes 1000
seconds to complete one frequency so it's a long time to wait to detect an error.

To scan from one frequency value to another two of the values can be the same as shown below:

Initial Frequency: 1Hz

Middle Frequency: 20Hz

Final Frequency: 20 kHz

These settings will scan form 1Hz to 20 kHz

Initial Frequency: 10 kHz

Middle Frequency: 1 Hz

Final Frequency: 10k Hz

These settings will scan from 10 kHz to 1Hz and back to 10 kHz.

Initial Frequency: 1 kHz

Middle Frequency: 1 kHz

Final Frequency: 1 kHz

Iteration = 100

These settings will repeat a single frequency (1 kHz) 100 times.

Notes on Potententiostats/Galvanostats

The Z100 system is designed to operate at its rated 100 kHz Bandwidth with minimum internal phase
shift. External Potentiostats/ Galvanostats, their internal settings, input cables and the External Cell
being tested will all affect the Magnitude and Phase response and the stability of the system.

The EA163 potentiostat operates with a <5 degree phase @100 kHz bandwidth at 100mA, 10mA and
TmA ranges, 10uA @15kHz and 1uA and below at 1.5 kHz. Measurement of high impedances
requires operations at lower bandwidths. In Galvanostat Modes similar performance is attainable but in
this case the possibility of instability (parasitic oscillations) is more likely due to the external cell and in
such case High Stability option is available that restricts operation to 1.6 kHz.

Z100 Reference Manual
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Hardware Installation

Connect the hardware as shown below:

System Requirements:

P4 or above CPU, Memory >512M,

Support USB port, suitable for WIN XP, Vista 32 or Windows 7 OS.

Front Panel Indicators

i ™y
Elactrochemical Impedanca Analyzer
zio00

Power  Active Busy Trigger
? o ol o)
L. A

Figure 5 Front Panel of Z100

Power: Power ON indicator
Active: ON when ready to run a measurement.
Busy: It's blinking when Z100 was running.

Trigger: On when triggered

Rear Panel Description

= 1.-

Racod Valzage: Ein
80250 VAC )?{
5060 Hr 80 VA
-—
AN st ot S ce
Made in Australia by aDAQ Pry Led, CN13808 Do NOT obstruct fan.
W T T =

Figure 6 Rear Panel of Z100

Ein: Voltage signal input from Potentiostat

lin: Current signal input from Potentiostat

Sig Out: Excitation signal from Z100 to potentiostat
I2C Bus: Communications cable to Potentiostat
USB: Communications cable to Computer USB port

Power: Mains input
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Typical System Interconnections/ External Cabling to EA163 POTENTIOSTAT

Refer to factory for connection to other
potentiostat

CPU

System
under Test

Figure 7 Z100 cabling to EA163 POTENTIOSTAT

When your hardware has been connected as shown in Figure 7, apply power — all indicator lights should
come on momentarily and then go off except for the Green Power LED and the Active LED. The
potentiostat should Indicate that it is OFF Line (green LED off) and the Overload Light is OFF to indicate
that there is no overload condition present.

Note: the Potentiostat Overload LED will be ON when the system is first switched on in order to confirm
that the Overload circuit is operational. The Overload light may remain ON until the Potentiostat is
accessed by the software for the first time at which point it the Overload light will be reset.

Your software can now be installed.

Z100 Reference Manual
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Software Installation

Insert your software CD in the CD tray.

Run Setup.exe and follow on screen prompts. Once installation is complete both Z100 Navigator and
ZMAN applications should be available in your Program folder and short-cut icons should appear on your
desk top. Click on the Z100 Navigator icon to initiate the program. On start up the Z100 Navigator
window will be displayed and will indicate that the Z100 and the attached potentiostat have been
detected (see below).

RO1C10010004(v1.2.2.1) with EA163
DLL v1.2.2.0

Copyright© 2010 WonATech Co., Ltd.
in cooperation with eDAQ Pty Ltd.
Click in window to continue All rights reserved.

On completion of its start up process — which can take up to a minute- the following Start up screen will
be displayed (Figure 8) to indicate that the system is ready for operation. The system is now ready for
use.

t 7100 Navigator, [RO1C09070001 v1.2.2.1 with EA163]

File Device Experiment Operation Tools Help
Resul | Monitoring | Lissajous | Myquist | Bode | A1 | a1z
Time Freq Z,Real 2,Imag ZMag  ZPhase  V,Real ¥,Imag YMag  VPhase
[s1 [Hz] [ohm] [Ohm] [Ohm] [Deo] [ohm] [Ohm] [Ohm] [Deo]
L]
Galvanostatic EIS H 1j13 : GEIS [10Hz] ”

Figure 8 Z100 Start up screen.
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System Configuration

A start up window Figure 9 will be displayed when the application is launched. It consists of a number of
menus described below to allow system configuration, experiment setup and provide monitoring and
data recording during experiments.

t 7100 Navigator [RO1C09070001 v1.2.2.1 with EA163]

File Device Experiment Operation Tools Help

lo Run ‘0 Stop | W

Result | Monitaring | Lissajous | Myaquist | Bode | ALl || AIZ

Time Freq Z,Real Z,Imag Z,Mag Z,Phase ¥, Real ', Imag ¥, Mag %,Phase Y
(5] [Hz] [ohm] [ohm] [ohm] [Deq] (=] [=] [=] [Deq]

Figure 9 Start up screen detail
File:

This menu item provides the means to open a file, save a file and open Recently used files. See Saving
Data section for more detail on data files naming and structure.

Device:

This Startup menu item ( Figure 10) provides facilities for detecting initializing and resetting Active 2100
devices and external Potentiostats. Some of these commands relate to circumstances in which multiple
Z100 are connected to the system. In most cases the Z100 system connected to your PC will be
automatically found, reset and installed and there is no need to initiate any of these commands.

Experiment  Cperakio

Scan for Devices

| Select Active Device [ 3
Reset Active Device

Initialize Input Settings
Loopback,

Initialize External P/G

Figure 10 Device Menu

Loopback: is an important setting that can be used in order to test the operational integrity of
the Z100 system. By selecting this item a self test of the Z100 can be performed - see Z100
Quick Start Manual for details of this procedure.

Initialize External P/G: this can be used to reset and initialize the external potentiostat.
Typically this command is performed automatically during startup so there will not be a need to
perform this command unless some condition occurs that prevents the potentiostat from
operating correctly or from being recognized by the Z100 system.

Z100 Reference Manual
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Experiment:

This is used for selecting the experiment to be performed. Either PEIS, GEIS can be selected and when
selected the appropriate setup command menu is displayed.

Operation:
Start and Stop Function Keys — other function Key initiated operations can be included here.
Tools:

This menu (Figure 11) provides an important set of commands described below

Transient recorder: this provides an independent method of generating a number of waveforms that
can be applied to a system under test. A full description is available at the end of this section.

Tools WslEs

Transient Recorder. .,

IIpdate Firmware & Calibrate Device, ..
Calibrate External Pl

File Converter. ..
Options, ..

Figure 11 Tools Menu

Update Firmware & Calibrate Device: no user intervention is normally required. This command
provides means to calibrate the system and upgrade the firmware. The calibration facility is normally
performed in the factory so it is not necessary for the user to perform this function. Firmware Updates
can be performed when new firmware becomes available and instructions for this operation will be
provided with the Firmware upgrade document.

Calibrate External P/G: this menu allows the external Potentiostat/Galvanostat to be calibrated. One
of the most important aspects of this section is the measurement of the Potentiostat “Blank” phase
response so that this data can be used to correct for phase distortion introduced by the Potentiostat and
the Z100. See the 2100 Quick start manual for a description of the procedure to perform this task.

File converter: Used for converting Z100 native files “Binary file” (*.wis, *.wiv) to “ASCII file” (*.z#,
* iv#). See Figure 12.

File extension convention:

*wis > AC Data (Voltage and Current data recorded during an EIS scan) > ASCII file *.z#

*.wiv > DC Data (records DC data recorded during running of Electrochemical techniques such as
Cyclic voltametry etc) ASCII file *.iv#. This operation is not currently implemented in Z100 Navigator.
DC data is saved when CV, LSV, and SWV techniques are enabled. Currently this feature is not
implemented in 2100 Navigator but is planned for future release.

ZMAN 2.2 Analysis and Modeling application supplied with your system will only open Binary File that
are generated on the Z100 system (*.wis files). If analysis of data recorded on other systems is required
a standalone ZMAN 2.2 license may be purchased from EDAQ.

Converting your files to the ASCII format (*.z#) provides the means for this data to be read by other
programs. Z100 users may want to export their data to Excel or Origin software for publication. This file
converter provides this facility.

Z100 Reference Manual
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Folder for AC data” is stored internally for subsequent use.

t File Converter rz|
Folder Far AC datal™, wis) -
|c:'u,z# Data -y
= Refresh
Ci\Z# Data|PEIS|2010-06-27\17-36-51 . wis i
CH\Z# DatalPEIS|2010-08-27417-44-55, wis
- Convert
CH\Z# DatalPEIS|2010-09-03409-36-22, wis
CH\Z# DatalPEIS|2010-09-03412-11-03.wis
Ci\Z# DatalPEIS|2010-09-03113-35-22, wis —

C:\Z# DatalPEIS12010-09-04410-11-44. wis
{3 CH\Z# Data|PEIS|Z010-09-0411 1-07-04. wis v

743Byte
|c:1z# Dats\PEIS|2010-06-27\1 7-36-38 wis |
Folder Far DC data (*.wiv) -
|c:1z# Data =
~
- Refrash
Converk:
to Tv#
——
b

O means that the file is already converted

Search subdirectaries
o S Close
Replace without confirmation

Figure 12 File converter menu

Options Menu See Figure 13 and the following sub- menus

General: some general set up commands defining start up scanning and conditions to be set at
the conclusion of an experiment.

File: Allows control of and file management settings. If Automatically save data option is
selected, Automatic file name and Data file format are enabled. See Fig 14

If the Automatic file name is enabled, EIS data is saved automatically in the Folder for AC
data. File format can be binary or ASCII.

t Options [‘S_<|

General | File ‘ EIS | External FiG

Automatically save data

[¥] Automatic File name

Data file format

| Binary(™®,wis, *wiv) w

Folder For AC data
|c:'u,z# Daka

Folder For DC data -
=

|c:1z# Data

o )

Figure 13 Options: File menu

If Automatically save data option is not enabled, data is not saved until you select File >Save
As Binary Format... or Save as ASCIl Format... in the File menu in the Main window.
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General | File | EIS | External PiG

Apply digital notch Filker

Mains Frequency |50 Hz .
Apply drift correction before analysis
[CIFast gain contral

[JEnable Filter gain

| Ok | [ Cancel

Figure 14 Options: EIS Menu

Options: EIS: See Figure 14

Apply digital notch filter: controls whether to use the internal digital notch filter. Select appropriate
mains frequency in your area.

Apply drift correction before analysis: During recording of an impedance spectrum, a potential drift
can occur. The magnitude of drift is time dependent and can be compensated by software during the
measurement.

The formula is E_ measured(t) = E_ true(t) + a*t + b and we can get E true(t) by linear regression.

Fast gain control: If true, PGA gain of each channel is calculated from the measured impedance and
set automatically to the most appropriate value. This can achieve faster EIS results.

If false, PGA gain is set by an iterative step-by step procedure: if the signal is too big, a lower gain is
chosen and if the signal is too small, a higher one is selected. It is useful to measure very small
impedances. In this case, measured impedance using inappropriate PGA gain may be significantly in
error.

Enable Filter Gain: PGA amplifier has up to +40 dB of gain (x100). The analog filter can provide an
additional X10 gain. It is useful in measuring very low impedance (i.e. ~100uV amplitude of sine wave);
however, calibration is not available at this extra gain.

External P/G: these controls provide some control of external 3 party Potentiostats. Because the
EA163 is recognized by the Z100 system and can communicate with the system directly its control
functions are available in the 2100 Navigator application.

Transient Recorder

The transient recorder module contains a number of systems that allow control over the various
elements of the Z100 system and a potentiostat attached to the system and in addition provide an
independent means to generate waveforms to test system performance. The notes below describe the
various functions provided by this software module (see Figure 15).

Z100 Reference Manual
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Hardware Appendix: Please refer to this Appendix when reading this section, it will provide some
useful information that will assist in understanding some of the hardware related features of this system.

Important Note: Some of the settings in this menu can affect the same system parameter from two
locations: from within the Transient Recorder menu or from the Experiment Set up menu. Each location
can control its own settings.

Analog Out: This section provides control over the Analog output excitation provided by the system
and appearing on the Sig Out terminal of the Z100. The following parameters are accessible:

Bias Voltage: A DC bias or DC potential can be applied to the sample under test. Maximum allowed
voltage is +/-10 Volts therefore the combination of DC bias and AC amplitude must not exceed 10Volts.

Cut Off Frequency: a user selectable filter may be applied to the output waveform.

t Transient Recorder [RO1C02070001 w1.2.2.1 with Unknown P/G]

Analog Out
Bias Yaltage Cuk OFF Frequency
oy - 10 kHz 4
Waveform
Frequency Ackual Fregquency
1kHz 999,999999Hz
Burst Mode
Annplitude Initial Phase vl =
yoles |17
SINE 1 0 deg -
pagError Wl
Transient Recard Al Configuration | External PG
im- Rl
500u- a1z -1
e =
x o+ -S00m B
5 -500u- -0 =
S| =
A --500m
-1.5m— 1 i i 1 i i 1 1 i 1 1 i 1 1 i 11
o 02505078 1 1,28 15175 2 225 25 275 3 325 35 375 4
Tine 5] HE o)
[JLoopback. Shiow Plak - fuis ¥-fixis
&C Coupling [1Apply Digital Filker Tirne: w || Scaled Data b

Figure 15 Transient Recorder screen

Waveform: Various waveforms can be selected and in addition arbitrary waveforms defined by an
analytical function can be generated and output at amplitudes, frequencies and Initial phase specified in
the menu. Waveforms can be output continuously or in Burst mode and when this is enabled the
number of cycles in a burst mode can be specified.
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Transient Record: This displays both the current and voltage appearing at | in and E in terminals of
the Z100. Axis Scaling will be automatic and any distortion will be visible.

Al Configuration

This tag provides information on the conditions applying to the last experiment. The two columns refer
to the current and voltage channel and provide further diagnostic information.

Transient Record | A Configuration

Enable Enable
Bias Bias
a -0.00294264
2ain 2ain
+4 dB w +28dE W
Cuk OFF Cuk OFF

150 kHz  » 150 kHz  »

* wWhen the external P)G is in GST mode
be read as AI 2(current) and AT1(vValkag

Figure 16 Transient recorder >Al Configuration

The above settings (see Figure 16) allow the user to control the gains of the Current and voltage
amplifiers as well as any applied bias, if there is distortion visible — reduce the gain and if there is too
much noise then increase the gain.

External P/G

This menu provides the means to set the operating parameters of the external
Potententiostat/Galvanostat. The Mode, Current Range and Filter setting, High Stab mode used in
Galvanostatic operations and the Cell arrangement can be configured.

Transient Record | AI Configuration | External PiG

Mode Cell
PST w {#) standby
Current Rangs ) Dy Cell
10004 w

() Real Cell
Filker
Filker CFf "

[] High-stability

[]Loopback Shiow Plak ¥-Bis Y¥-fixis
&C Coupling &pply Digital Filker Tirne * | |Scaled Data b

Figure 17 Transient Recorder> External P/G
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Cell Configuration:

Standby: in this mode the system is internally connected to the Dummy cell and the
connections to the external cell are all “open” so that the system can have no effect on the
external cell. If this setting is chosen the system will switch to the Real Cell when the
experiment begins and switches back to Standby mode at the completion of the experiment.

Dummy Cell: this setting connects the potentiostat to the internal 100 kohm internal cell

Real Cell: this setting connects the potentiostat to the External (Real) Cell. Any experiment will
be performed on this cell and at the end of the experiment the cell will stay connected.

Loopback: Connects the Z100 output to its input in order to test the system with no external devices.
See Quick Start manual.

AC coupling: See Hardware ADDENDUM. This setting removes any DC offset.
Apply Digital Filters: See Hardware ADDENDUM. Applies post acquisition digital filters.

X and Y axis: These controls allow the display in real units (time and Current or voltage) or in actual
ADC readings (number and value). This can be used as a diagnostic test to show if the ADC converter is
operating within its linear limits.
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Monitoring and Data recording

This section describes the monitoring and recording features of the software. The contents and
functions of the various buttons and menu items will be described below.

¥ 7100 Mavigator [RO1C09070001 v1.2.2.1 with EA163] M=

File Device Experiment Operation Tools Help

lo Run ‘0 Stop |

Result | Manitaring || Lissajous || Myquist || Bode || all || alz |

Time Freq Z,Real Z,Imag Z,Mag Z,Phase ¥, Real ', Imag ¥, Mag %,Phase Y
(5] [Hz] [ohm] [ohm] [ohm] [Deq] (=] [=] [=] [Deq] B

Figure 18 Start up screen Detail

At the bottom of the startup screen there are three items which will first be described.

Potentiostatic E15 || 17/17 1 PEIS [10Hz] || C:\2# Data\PEIS|2010-09-03109-36-22
—_— ]

Figure 19 Start up summary line

Galvanostatic EIS or Potentiostatic EIS:

Accessing this item brings up a Command menu (see Fig 2) that allows either a PEIS or GEIS
experimental conditions to be defined. The experiment that will be run when the Run button is activated
is defined here.

1/13 GEIS or PEIS:

This item brings up the complete list of steps that will be undertaken in carrying out the next
experiment. During data acquisition this item will indicate the step reached.

t Steps El

Steps

113 : GEIS [10Hz]

2{13 1 GEIS [17.7826Hz]
313 1 GEIS [31.6226Hz]
4f13 : GEIS [56.2341Hz]
5{13 1 GEIS [100Hz]

6(13 1 GEIS [177.828Hz]
7113 1 GEIS [316.228Hz]
/13 1 GEIS [562.341Hz]
13 : GEI3 [1kHz]

10/13 : GEIS [1.,77628kHz]
11/13 ¢ GEI5 [3,16228kHz]
1213 1 GEIS [5.62341kHz]
13713 1 GEIS [10kHz]

>

~

Figure 20 List of Experiment Steps
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File destination

The destination of the experiment file will be automatically generated by the system and the location will
be displayed in the RHS cell.

Run/Stop Buttons and Activity Indicators

These commands START and STOP an experiment and indicate progress as the experiment proceeds.

The Start command will begin the experiment and it can be terminated at any time by the Stop
command —waiting until the experiment is completed will result in a complete data file stored in the
location indicated at the bottom RHS of the display.

Results
Once an experiment is started and data obtained it will be displayed in the Results table.

Result | Monitoring | Lissajous | Myouist | Bode | AI1 || Iz

Time Freq Z,Real Z,Imag Z,Mag Z,Phase ¥, Real ¥, Imag ¥,Mag ,Phase s
[=] [Hz] [Shm] [Shm] [hm] [Deq] [=] [=] (=] [Deq]
" 9,086 100000 S067. 69 422,602 085,28 4, 76695 0,00019596¢ -16,3419E-6 0,00019664¢ -4, 76695

12,418 S6z34.1 043,33 243,657 S049,31 2, 75803 0.00019751: -9.63520E-6 0.000193047 -2, 75003
15,786 316228 4930.14 603,358 4966,92 697726 000019954, -24 4569E-6 0.00020133 -6,97726

19.112 17782.8 4959.05 45,561 4959,29 0.561045 0.00020163: -1.97446E-6 0.00020164; -0,561045
22632 10000 4955,99 21,0092 4956,03 0.242885 0.00020177: -855.346E-9 0.00020177« -0,242885
26,583 562341 495325 9.07686 4953,28 0.104994 0.00020188¢ -369,955E-9 0,000201588¢ -0,104994

Figure 21 Results Table

When an experiment is started the system displays an Analysis Status (see Figure 22) which will indicate
the condition of the input signals. As the system automatically adjusts for optimum settings it will
indicated that at some settings the signals may be too noisy, too small or too large. Eventually it will
indicate that All channels are OK and measurements can proceed and the above table of results
displayed. It is for this reason that it is advised that experiments start from High frequencies as these
measurements can be done more quickly in case some problems prevent optimum conditions to be
found. If appropriate conditions are not found the system will try a number of times and then stop.
Connections to the system under test should be checked and possibly new experimental or equipment
parameters should be selected.

Analysis Status
All channels OF
Crverload
Tao noisy of no signal
Signal oo small
Signal koo large

Figure 22 Analysis Status

As the experiment proceeds results will be displayed as a table of real and imaginary impedance and
admittance values as well as in various graphical forms accessible at any time during the experiment by
selecting the other menus available in this screen:

Monitoring: display voltage and current waveforms
Lissajous: displays an x-y plot of current and voltage data highlighting phase shifts

Nyquist: displays real vs imaginary impedance
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Bode: displays amplitude and phase vs Frequency
Al1: Current vs Frequency, spectral and error data
Al2: Voltage vs Frequency, spectral and error data

These screens display various forms of the data and a number of common controls are available to assist
in the evaluation of this data. These common graphical features are described below:

[+ ]

Figure 23 Graphics control icon located in the top left hand corner of each screen:

The first Icon rescales the data to fit in the display.

o (B e
The second icon opens and closes a Graph Palette HEd at the bottom right hand corner that
provides the means to magnify move and select sections of the display. The third icon brings up a cursor
that displays X and Y values of cursor position. The cursor is constrained to move to experimental data.

Clicking with the right button within a graph area brings up a selection that allows various functions
such as copy data or graph to clipboard and a subsequent click of the left Button in the same area will
bring up various options with regards to graph type, graph color and line type.

The Data display screens available are described below.

Monitoring

While acquiring experimental data, the Z100 Navigator monitor screen displays the incoming current
and voltage waveforms. Typically the PEIS applied voltage will be 100mV and its scale is displayed on
the RHS and the Current scale is displayed don the LHS.

% 7100 Navigator [RO1C09070001 v1.2.2.1 with EA163] []i=1E3

Eile Device Experiment Operation Tools Help
|n@ stop | IDLE
Result | Monitoring | Lissajous | Myquist | Bode | ALl | &Iz
[a]
22u- -110m
200~ Ath -100m
180 -] Ik -90m
160 -] ~B0m
14| ~70m
12u-| -60m
10u-| =S0m
Bu | ~40m
G| ~30m
= 4u] -20m  §
z -on 8
L -0 B
§ -2u-| --10m E
S -u-| -20m S
-6 | --30m
-Bu | —-40m
-100-] —-50m
-12u-] --60m
-14u -] --70m
-16u -] —-80m
180 —-%0m
200 | --100m
22u- T T T T T T T 1--110m
a 0.1 0z 0.3 0.4 s 0.6 o7 0.5
Time [5]
Potentiostatic EI5 17§17 : PEIS [10Hz] C\Z# DataPEIS|2010-09-03113-36-22

Figure 24 Monitoring screen
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Lissajous

While acquiring experimental data, the Z100 Navigator Lissajous screen displays the relationship the
Current and Voltage waveforms in terms of their phase relationship. A Graphics pallet tool provides the
zoom function and the ability to copy the data. Additional pallets as described above provide the means
to modify the display in terms of line color and type.

t 7100 Navigator [RO1C09070001 v1.2.2.1 with EA163]

File Device Experiment Operation Tooks Help

[0 & O sw | [mes —

Resuk | Monitoring | Usssjous | wyqust | Bode | 1L | A12

&[a][o]

200+ 2 [
1607 Fited [

Current [4]
-

3 T T T T T
-150m -100m -50m 0 S0m 100m 150m

volkage [V]
| Potentiost atic E15 |[ 1717+ PEIS L1oke] || ciz# patalpersizo10-05-03115-35-22

Figure 25 Lissajous Figure
Nyquist
The Nyquist screen displays a plot of Real and Imaginary Impedance values as shown in the plot below

By clicking in the graph top RHS corner the cursor pallet can be displayed and numerical data associated
with each point will be displayed.

t Z100 Navigator [RO1C09070001 vi.2.2.1 with EA163]

Fie Device Experiment Qperation Iook Help

© w10 =] ) [

Result | Monitoring | Ussajous | Myaust | Bode | AlL | AI2

FIENES

1.5k

1T ] =

1.3k-| . .

14k

1,2k
1.1k

1k-|
900
00~
700+

2" [ohm]

600-| .
500-| = .
400-|
300-|

200+

100-|

0|

100 T T T T 0 T 0 T T T T T T 1
0 250 500 750 1k 1.25k 1.8k 1.75k 2k 2.25k 2.5k 2.75k 3k 3.25k 3.5k
ohm]

| Potertiostatic EI5 || 4040 : PEIS [1H2) || citz# pateipEISiZO10-08-18i16-34-40

Figure 26 Nyquist Plot Section
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Bode Plot

The plot of signal Magnitude and Phase is displayed in a Bode plot as shown below.

t 7100 Navigator [RO1C09070001 v1.2.2.1 with EA163]

File Device Experiment Operation Tools Help
© w0 O s | I
Result Maonitaring Lissajous Myquist | Bode | ALl ALZ
wlaf+
10k
21 [
i soosessrnnng,,
£ -
5 %
.

o
g o e,
= L™
2 LTI TR T
=

100-; i i i ] i i

100m 1 10 100 1k 10k 100k
Frequency[Hz]
10+
2 )
— .®
o h...... ...n"
. o
=107 ., -
& . ¢
- .

B 20 - i
£ .

-30-] & ui

N . ¥ Axes
=05 . ™ 12| & Phase v
.
.
et
-50 I ] [l ] = ] [} 1
100m 1 10 100 1k 10k 100k
Frequency[Hz]
Patentiostatic EI5 ” 40440 | PEIS [1Hz] || o7 Dak=|PEIS|2010-08- 19116-34-40

Figure 27 Bode Plot

With the cursor enabled, a view of the data showing numerical values associated with each point, can
be provided.

Result | Monitoring Lissajous | Myquisk | Bode ‘ ALl A1z

21 Bl Time

Magnitude [Ohm]

1k} 0 ] ] |
1 10 100 1k 10k 100k 12| [ohm]

Frequency[Hz] 4,958k

7=
21 .Izl Phase [Deqg]
- 242 885m
5]
g 4
1=
2 3] P
b}
& 24
1-] ¥ Axes
.
i R e S i, B T |z & Phase -
71_\ ] ] T 1
1 10 100 1k 10k 100k

Frequency[Hz]

Figure 28 Bode Plot, Cursor enabled
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Current & Voltage Time and Frequency domain data

The top graph displays the raw data, overload data (if exists) and the fitted data. The Z100 Navigator
manipulate the raw data by drift correction, offset canceling, and sine-fitting process. The calculation of
impedance is based on the fitted data.

The power spectrum graph displays the frequency content of the signal; this is used to evaluate the
signal to noise ratio and other error terms. Typical EIS data shows the level of harmonics and noise is
below -60 dB (1/1000). You can also evaluate the quality of measurement by Signal in Noise and
Distortion (SINAD) and Total Harmonic Distortion and Noise (% THD+N) in the right box. Higher SINAD
and lower %THD+N, indicates better measurements.

In most cases the dominant frequency will be the applied frequency and the other terms will be over
1000 times smaller. In the example below the noise frequency terms are individually about 1,000,000
times smaller. As the operating frequency increases in value its noise and distortion component will
increase until eventually the measured signal is lost in noise.

t 7100 Navigator [RO1C09070001 v1.2.2.1 with EA163]

File Device Experiment Operation Tools Help
lo Run |0 Stop ‘ IDLE
Result | Monitoring || Lissajous | Myquist | Bode | ALL | A2
S AL
SINAD[dE]
_ @ THD[dB]
z
e SMR[E]
:
< 100 o
e -13.406986u
AC Amplitude
-30u-} ; . ; ; ; ; . ; ; ] 28,988189u
0 200m  400m  600m  800m , 1 12 14 16 1.8 2 Phase[deq]
me [=] 113,206
0- a1 Compaonent
-25] | === 18,80 +8.080 |
S
g - o [7]
8 75
2
g -100-]
I -125-
o
£ -150-
m
& 175
-200-] T
-225-] T I ] 1
100m 1 10 100 1k
Frequency [Hz]
Patentiostatic EIS || 4040 ; PEIS [1Hz] ” C:\Z# Data\PEIS|2010-08-19116-34-40

Figure 29 Time and Frequency Domain plots
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Saving Data

In its default mode 72100 Navigator data is saved automatically in C:\Z# Data folder.

Data storage structure

The 7# Data folder is located in your master hard drive(C:\). Its structure is shown below. Folders are
automatically generated for each type of experiments performed on different dates. Data files are
automatically generated based on time data. Z100 Navigator thereby manages your data to make it easy
to find an experiment or group of experiments for analysis with ZMAN.

X ame

= [C3) Z# Daka A V510-11-44 wis

|5 <alibration Folder Wi 11-07-04. wis

I GEIS I#11-07-04.2#
15 GHFR.
B I PEIS

(L) 2010-08-20

() 2010-08-24

[ 2010-08-25

[ 2010-08-27

[ 2010-09-03

(&) -010-09-04

Folders

Figure 30 Structure of the Z# Data folder

Data Storage

Size  Type

3KE  WonATech WIS Data File

4KE WonATech WIS Data File
10KE ‘WonATech Z# Data File

Data storage is controlled by Tools>Options> File menu. Default conditions are shown

¢ Options

General | Filex | EIS | External Pia

K

[#] Automatically save data

Automatic file name

Data file format

|Binarv(*.wis, Fiin ) “

Folder For AC data
|c:1z# Data

Falder For DC data
|c:12# Data

Y [¢]

| (o] 4 | [ Cancel

]

Figure 31 Tools>Options>File menu

Date Maodified

(412010 10:14 &M
9/4/2010 11:11 AM
9)4/2010 11:18 AM

in the figure

By selecting Automatically save data the data will be saved in the structure defined above. If this
mode is disabled the user will need to perform this function manually.

Folders for AC Data specifies the folder where Impedance data will be stored.

Automatic file name will generate either Binary (*.wis) or ASCII (*.z#) format files with the name
generated from the date and time: Month/Day/ YEAR Hour:Min AM/PM as shown below.
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Wis 1 1-07-04.wis
Z# 11-07-04. 24

Figure 32 Data file listing

ASCIl Data

4KE WonaTech WIS Data File
10KE wWonATech Z# Data File

9)4/2010 11:11 AM
9/4/2010 11:18 AM

Data can also be saved directly from the File Menu. This useful if it is required to move the experiment
data to an alternative analysis or display program. If ASCIl format is selected and the file saved to the
desktop the following icon will appear.

The *z# file can be viewed with the Windows NotePad and it appears in the tabular format below and

includes both the experimental data information and all the numerical data captured by the experiment.

File Edit Format Wiew Help

Tazk : PEI=

DELAY @ FALSE

TDELAY : 100 s

SDELAY @ 0 mv/s

WDiZ o 0. 000000E+0 W

WAC 1 100, 000000E+0 myv
FREQINIT : 1.000000E+0 Hz
FREQMID @ 1.000000E+0 HZ

FREQFINMAL : 100, 000000E+3
DEMSITY : 10 Pt/ /Decade
ITERATION @ 1

TRANGE @ 1

AUTOIRANGE @ FALSE
LIMITL : 1&

LIMTZ @ 2

LIMITS : 2 =

CELL : TRUE

HISTABE : FALSE
PHASE : TRUE

Freguency

L 99009000 5E-1
L 29154 99909E+0
LGGEEL00999E+D
L154435000E+0
LFEZ559000E+0
L 993E13996E+0

. 90484 3000E4+0
. F42636998E40
L 900009809095E+0
L 291549698E+1
L BEE1L00500E+]L
154434 700E+1
L FB2559596E+1
L5993B15F00E+L

Lo Tod Tod 22 2 D ) n s Lad P Bl 2

Figure 33 ASCII data (not all numerical data is shown).

=
4
4
4
4
4
4
.04 158E990E+0 4.
4
4
4
4
4
4
4
4

HZ

924677834 E+3
L9287984 61E+3
L9274 20907ESS
9212031 27E+3
LOLFO021 5443
923725585643

019815314E+3

. 924683100643
L 921645001E4+3
LB25222599E+3
LB23123005E+3
LB25356324E+3
LB21671098E+3
L B24010197E+3
L 927564008643

Z_Imag

-5.445145922E+0
3.320925360E+0
-2.159085344E+0
-3.7665079650E+0
-6, 502588907E+0
-9.662821134E-1
2.3367753846E+0
1.5930461424E40
2.227207005E+0
-1.431531978E+0
-2.697989719E+0
-1.138838262E+0
1.926610687E-2
-3.8B3217683E+0
-4.102999882E4+0

Z_Mag

A R N R N N A A A A L 9

L 92468084 SE+3
L9297075T9E+3
92754 3430E+3
L 921204 S68E+3
LB179064 55E4+3
923725680643
. 91981 3869E+3
924683482643
L921645505E43
L925222807E+3
L923123744E+3
L 9253564 56E+3
LB21671098E+3
LB240911728E+3
LB27366317E+3

The alternative method of converting Z100 Binary data is by using the Tools>File converter menu. In
this case only the numerical data is recorded.
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Addendum: Hardware configuration

There is no need to understand the internal hardware and software details of this system in order to be
able to use it and produce good results. However some understanding of the internal structure could be
helpful in guiding the user to better utilize the features of the system. This addendum provides this
background information.

Z100 EIS Potentiostat

AO Excitation ‘

Al 2 Voltage 7 Cell

under test

To PC

Al

Basic Structure showing the generation of an AQ Excitation signal and the subsequent
measurement of the Al 1 and Al 2 signals in order to compute the complex impedance

Z = Al 2/Al 2 = Mag & Phase

Figure 34 Basic Hardware structure

waveforms are applied to the potentiostat and the voltagés and currents across the Cell under test is
measured by the Potentiostat and returned to the Z100 for processing and display.

The first element to be described is the Z100 AO channel (Sig Out). This consists of two precision Digital
to Analog Converters (DAC's) one of which generates the Excitation signal and the other generates a DC
voltage that is used to apply a Bias or Applied DC potential. These two signals are added to produce a
DC level with an excitation signal superimposed. This signal is filtered (reconstruction filter) to remove
DAC noise to produce a smooth output waveform. This arrangement is shown in the diagram below.

The Voltage (Al 2) and Current (Al 1) signals are processed by the Z100 to generate the Impedance data.
Note that these two channels are identical and in some circumstances may be reversed by the
potentiostat when it is operating in Galvanostat mode. (e.g. GEIS).
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Bias Woltage Cuk OFf Frequency

—> Y = 150 kHz | ¢

DC Potential

Excitation DAC

—

AQO Channel Block diagram

Reconstruction Output
Filter Amplifier

Figure 35 Analog Output Channel Block diagram

These signals will contain two components: a small sinusoidal AC waveform superimposed on a DC
value. In order to measure the AC component accurately the DC component must first be removed
before the AC waveform can be amplified.

Al Channel Block Diagram

i1z

Enable Enable Enal

Bias Bias Bias
U e | |
H Gain Gain iGain

e +46.02 W +28dB ~ -44 di

H Cut off cut Off cut off

[haie i 150kHz  w 150kHz & Muts

* When ths external PJG is in GST mode, Al 1 an
be read as Al Z{current) and Al1(Voltage) respe:

[Loopback Shaw Plat
[¥] AC Coupling

ADC +/-2Volts | Notch Filter — Digital Filter

Bias removal DAC : AC coupling

Figure 36 Current & Voltage input channels
To achieve this purpose these identical channels contains the following elements described below.
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x 0.1 Input amplifier that reduces potentially high input voltages down to a level that the system can
handle (<10volts max).

Bias DAC provides an adjustable Bias voltage to remove any DC component in the input channel up to
+/-100Volts. This enables the PGA to amplify the AC component. This in effect is a form of AC
coupling implemented using a DC technique. In some circumstances it may be necessary to add the DC
component back into the scaled data. To do this switch off the AC Coupling flag and the DC removal
will still take place but the value of the DC bias will be added back into the experimental data.

PGA Programmable Gain Amplifier can provide adjustable gain with an approximate range of gains
from x0.01 to x400.

Note: high gains inevitably result in higher noise levels so ensure that the system operates at levels as
high as allowed by experiment being carried out. The output from the PGA must produce a signal in the
range of +/-2.000 volts to suit the input range of the ADC.

Analog Filter is a Low Pass filter which can be digitally selected from 10 kHz to 150 kHz in 10 kHz
steps. PGEIS and PGEIS experiments select this setting automatically to track the frequencies being
measured. This filter also has an additional gain of x10 available when really low level signals need to be
measured. However adding gain is not without cost and signal to noise ratio is reduced. This additional
gain can be controlled in the Tools>Option>EIS menu: enable filter gain but in most cases this extra
gain is not used.

ADC: a precision Analog to Digital Converter which converts the analog data for subsequent digital
processing.

Notch Filter this filter is implemented as a digital filter in the Z100 Navigator application. It is used to
remove Mains frequency noise and this must be set in the Tools>Option>EIS menu: Apply digital
notch frequency.

Digital Filter this filter is also implemented as a high order digital filter in the Z100 Navigator
application. It is a very sharp cut-off frequency filter and when enabled is used automatically to track
the filter setting of the analog filter and remove frequencies above the frequency required by the
measurement. It can be enabled or disabled Tools>Option>EIS menu: Apply digital filter.
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